
PCB 设计入门 

概要 

本章旨在说明如何生成电路原理图、把设计信息更新到 PCB 文件中以及在 PCB

中布线和生成器件输出文件。并且介绍了工程和集成库的概念以及提供了 3D PCB

开发环境的简要说明。 

欢迎使用 Altium Designer，这是一个完善的适应电子产品发展的开发软件。本

章将以"非稳态多谐振荡器"为例，介绍如何创建一个 PCB 工程。 

创建一个新的 PCB 工程 

在 Altium Designer 里，一个工程包括所有文件之间的关联和设计的相关设置。

一个工程文件，例如 xxx.PrjPCB，是一个 ASCII 文本文件，它包括工程 里的文

件和输出的相关设置，例如，打印设置和 CAM 设置。与工程无关的文件被称为"

自由文件"。与原理图和目标输出相关联的文件都被加入到工程中，例如 PCB，

FPGA，嵌入式(VHDL)和库。当工程被编译的时候，设计校验、仿真同步和比对都

将一起进行。任何原始原理图或者 PCB 的改变都将在编译的时 候更新。 

所有类型的工程的创建过程都是一样的。本章以 PCB 工程的创建过程为例进行介

绍，先创建工程文件，然后创建一个新的原理图并加入到新创建的工程中，最后

创建一个新的 PCB，和原理图一样加入到工程中。 

作为本章的开始，先来创建一个 PCB 工程： 

 

图 6-1 PCB 工程的创建 

1.选择 File>>New>>Project>>PCB Project，或在 Files 面板的内 New 选项中单

击 Blank Project (PCB)。如果这个选项没有显示在界面上则从 System 中选择

Files。也可以在 Altium Designer 软件的 Home Page 的 Pick a Task 部分中选

择 Printed Circuit Board Design，并单击 New Blank PCB Project。 

2. 显示 Projects 面板框显示在屏幕上。新的工程文件 PCB_Project1.PrjPCB

已经列于框中，并且不带任何文件，如图 6-1 所示。 

3.重新命名工程文件（用扩展名.PrjPCB），选择 File>>Save Project As。保

存于您想存储的地方，在 File Name 中输入工程名 Multivibrator.PrjPCB 并单

击 Save 保存。 

下面我们将会创建一个原理图文件并添加到空的工程中。这个原理图就是教程中

的例子非稳态多谐振荡器。 



创建一个新的电气原理图 

通过下面的步骤来新建电路原理图： 

1.选择 File>>New>>Schematic，或者在 Files 面板内里的 New 选项中单击

Schematic Sheet。在设计窗口中将出现了一个命名为 Sheet1.SchDoc 的空白电

路原理图并且该电路原理图将自动被添加到工程当中。该电路原理图会在工程 

的 Source Documents 目录下。 

2.通过文件 File>>Save As 可以对新建的电路原理图进行重命名，可以将通过文

件保存导航保存到用户所需要的硬盘位置，如输入文件名字

Multivibrator.SchDoc 并且点击保存。 

当用户打开该空白电路原理图时，用户会发现工程目录改变了。主工具条包括一

系列的新建按钮，其中有新建工具条，包括新建条目的菜单工具条，和图表层面

板。用户现在就可以编辑电路原理图了。 

用户能够自定义许多工程的外观。例如，用户能够重新设置面板的位置或者自定

义菜单选项和工具条的命令。 

现在我们可以在继续进行设计输入之前将这个空白原理图添加到工程中，如图

6-2。 

 

图 6-2 新建电路原理图 

添加电路原理图到工程当中 

如果添加到工程中的电路原理图以空文档的形式被打开，可以通过在工程文件名

上点击右键并且在工程面板中选择 Add Existing to Project 选项，选择空文

档并点击 Open。更简单的方法是，还可以在 Projects 面板中简单地用鼠标拖拽



拉空白文档到工程文档列表中的面板中。该电路原理图在 Source Documents 工

程目录下，并且已经连接到该工程。 

设置原理图选项 

在绘制电路原理图之前要做的第一件事情就是设置合适的文档选项。完成下面步

骤： 

1.从 menus 菜单中选择 Design>>Document Options ，文档选项设置对话框就会

出现。通过向导设置，现在只需要将图表的尺寸设置唯一改变的设置只有将图层

的大小设置为 A4。在 Sheet Options 选项中，找到 Standard Styles 选项。点

击到下一步将会列出许多图表层格式。 

2.选择 A4 格式，并且点击 OK，关闭对话框并且更新图表层大小尺寸。 

3.重新让文档适合显示的大小，可以通过在中选择 View>>Fit Document。在

Altium 中，可以通过设置热键的方法让菜单处于激活状态。任何子菜单都有自

己的热键用来激活。 

例如，前面提到的 View>>Fit Document ，可以通过按下 V键跟 D键来实现。许

多子菜单，比如 Eidt>>DeSelect 能直接用一个热键来实现。激活

Eid>>DeSelect>>All on Current Document，只需按下 X热键，并且按下 S热键

即可。 

下面将介绍电路原理图的总体设置。 

1.选择 Tools>>Schematic Preferences ，来打开电路原理图偏好优先设置对话

框。这个对话框允许用户设置适用于所有原理图定的为全球局配置参数的偏好设

置，适用于全部原理图。 

2.在对话框左边的树形选项中单击 Schematic-Default Primitives，激活并使

能 Permanent 选项。单击 OK 以关闭该对话框。 

3.在您开始设计原理图前，保存此原理图，选择 File>>Save [快捷键：F，S]。 

画电路原理图 

接下来可以开始画电路原理图。本章将使用如图 6-3 所示的电路图为例进行讲解。

这个电路是由两个 2N3904 三极管组成的非稳态多谐振荡器。 



 

图 6-3 非稳态多谐振荡器  

加载元件和库 

Altium Designer 为了管理数量巨大的电路标识，电路原理图编辑器提供了强大

的库搜索功能。虽然元件都在默认的安装库中，但是还是很有必要知道如何通过

从库中去搜索元件。按照下面的步骤来加载和添加图 6-3 电路所需的库。 

首先我们来查找型号为 2N3904 的三极管。 

1.点击 Libraries 标签显示 Library 面板，如图 6-4。  

2.在 Library面板中点击Search in按钮，或者通过选择Tools>>Find Component，

来打开 Libraries Search 对话框，如图 6-5 所示。 

3.对于这个例子必须确定在 Options 设置中，Search in 设置为 Components。

对于库搜索存在不同的情况，使用不同的选项。 

4.必须确保 Scope 设置为 Libraries on Path 并且 Path 包含了正确的连接到库

的路径。如果在安装软件的时候使用了默认的路径，路径将会是 Library。可以

通过点击文件浏览按钮来改变库文件夹的 路径。对于这个例子还需得确保

Include Subdirectories 复选项框已经勾选。 

5.为了搜索所有 3904 的所有索引，在库搜索对话框的搜索栏输入*3904*。使用*

标记来代替不同的生厂商所使 

用的不同前缀和后缀。 

6.点击 Search 按钮开始搜索。搜索启动后，搜索结果将在库面板中显示。 



 

图 6-4 库面板 

 

图 6-5 库搜索对话框 



7.点击 Miscellaneous Devices.IntLib 库中的名为 2N3904 的元件并来添加它。

这个库拥有所有的可以利用于仿真的 BJT 三极管元件标识。 

8.如果选择了一个没有在库里面安装的元件，在使用该元件绘制电路图前，会出

现安装库的提示。由于 Miscellaneous Devices 已经默认安装了，所以该元件

可以使用。 

在库面板的最上面的下拉列表中有添加库这个选项。当点击在列表中一个库的名

字，在库里面的所有元件将在下面显示。可以通过元器件过滤器快速加载元件。 

在电路原理图中放置元件 

第一种要在电路图中放置的元件为三极管，Q1 和 Q2。电路图的大概布局将参照

图 6-3 所示。 

1.选择 View>>Fit Document 让，原理图表层全屏显示。 

2.通过 Libraries 快捷键来显示库面板。 

3.Q1 和 Q2 为 BJT 三极管，所以从 Libraries 面板顶部的库下拉列表中选择

Miscellaneous Devices.IntLib 库激活当前库来激活这个库。 

4.使用 filter 快速加载所需要的元件。默认的星号*可以列出所有能在库里找到

的元件。设置 filter 为*3904*，将会列出所有包含文本 3904 的元件。 

5.2N3904 将选择该元件 2N3904，然后点击 Place 按钮。或者，直接双击该元件

的文件名。光标会变成十字准线叉丝状态并且一个三极管紧贴着光标。现在正处

于放置状态。如果移动光标，三极管将跟着移动。 

6. 放置器件在原理图之前，应该先设置其属性。当三极管贴着光标，点击 TAB

键，将打开 Component Properties 属性框。把该属性对话框设置成如图 6-6 所

示。 



 

图 6-6Component Properties 属性框 

7.在 Properties 对话框中，在 Designator 栏输入 Q1。 

8.接下来，必须检查元件封装是否符号 PCB 的要求。在这里，使用的集成库对于

中已经包含了封装的模型以及和仿真模型电路都已经包括了。确认调用了封装

TO-92A 封装模型包含在模块中。保持其他选项为默认设置，并点击 OK 按钮关闭

对话框。 

现在开始放置器件： 

1.移动光标，放置三极管在中间靠左的位置。点击鼠标或者按下 ENTER 键来完成

放置。 

2.移开光标，在原理图上将出现该三极管，并且仍旧处于放置器件状态，三极管

仍然贴着光标。Altium Designer 的功能是允许反重复放置同一器件。所以，现

在放置第二个三极管。由于该三极管跟原来的一样，因此所以在放置器件时不需

要再次编辑器件的属 性。Altium Designer，将自动增加 designator 的名字中

的数字后缀。所以这次放置的三极管的 designator 将为 Q2。 

3.当参照示例电路图（图 6-3）日志的时候，将发现其实 Q2 为 Q1 的镜像。通过

按下 X键来改变放置器件的方向。这将使元件沿水平方向方向翻转。 

4.移动光标到 Q1 的右边，为了使得位置更加准确，点击 PAGE UP 键两次来放大

画面。这样可以看到栅格线。 

5.点击 ENTER 来放置 Q2。每次放置好一个三极管，又会出现一个准备放置的三

极管。 

6.所有三极管都放置完毕后，可以通过点击右键或按下 ESC 键来退出放置状态。

光标又回到的原来的样子。 

接下来放置四个电阻： 

1.在库面板中，激活 Miscellaneous Devices.IntLib 库。 

2.设置 filter 为 res1 。 

3.点击 Res1 来选择该器件，这样一个电阻元件符号将贴着光标。 

4.按下 TAB 来编辑属性。在属性对话框中，设置 designator 为 R1. 

5.在模模型块列表中确定 AXIAL-0.3 已经被包含。 

6.PCB 元件的内容由原理图映射过去，所以这里并且设置 R1 的大小为 100k。 

7.由于不需要仿真，所以设置 Value 参数中的 Visible 选择为非使能。 

8.按下空格键使得电阻旋转 90°，位于正确的方向。 

9.把电阻放置在 Q1 的上方，按下 ENTER 完成放置。不用担心如何连接电阻到三

极管，在连线部分将会做说明。 

10.接下来放置一个 100K 的电阻 R2 于 Q2 的上方。DesigntorDesignator 的标号

会自动增加。 

11.剩下的两个电阻R3和R4的大小为1k，通过TAB键设置它们的CommnetComment

为 1k，确认 Value 的 Visible 选项非使能，点击 OK 按钮关闭对话框。 

12.放置 R3 和 R4 如图 6-1 所示，并通过点击右键或 ESC 退出。 

现在放置两个电容： 

1.电容器件也在 Miscellaneous Devices.IntLib 库中，该库已经选择了。 

2.在 Libraries 面板的元器件过滤区内输入 cap 于 filter。 

3.点击 CAP 来选择该器件，点击 PLACE，这样一个电容元件符号将贴着光标。 

4.通过 TAB 键设置电容属性。设 disigatordesignator 为 C1，Comment 为 20n，



Visible 为非使能，PCB 封装为 RAD-0.3。点击 OK。 

跟设置电阻一样，如果需要仿真，则需要设置 Value 的值。这里不需要仿真，所

以 Value 设置为非使能。 

5.跟前面一样，放置电容。 

6.通过右键或 ESC 退出。 

最后一个需要放置的器件是 connector，位于 Miscellaneous 

Connectors.IntLib 。 

1. 在库面板中，选择 Miscellaneous Devices.IntLib 库。需要的 connector

为 2 排针，所以 filter 设置为*2*。 

2. 点击 Header 2 来选择该器件，点击 PLACE。通过 TAB 键设置电容属性。设

disigatordesignator 为 Y1，Visible 为非使能，PCB 封装为 HDR1X2。点击 OK。 

3.在放置前，按下 X键，使得器件处于垂直方向。然后放置 connector 器件。 

4.退出放置。 

5.File>>Save 来保持原理图。 

现在已经放置完所有的元件。元件的摆放如图 6-7，可以看出这样的放置留了很

多空间来  

 

图 6-7 所有元器件放置完成的原理图 

连线元件管脚。这一点非常重要，因为不可能连接位于管脚正上方的管脚。 

如果想移动元件，点击，并保持，拖动元件到用户想要的位置。 

电路连线 

连线是处理电路中不同元件的连接。按照图 6-3 来连接电路原理图，完成下面的

步骤。 

1.为了使电路图层美观，可以使用 PAGE UP 来放大，或 PAGE DOWN 来缩小。保持

CTRL 按下，使用鼠标的滑轮可以放大或缩小图层。 

2.首先连接电阻 R1 到三极管 Q1。在菜单中选择 Place>>Wire 或者在连线工具条



中点击 Wire 来进入绘线模式。光标会变成 crosshair 十字准线模式。 

3.把光标移动到 R1 的最下面，当位置正确时，一个红色的连接标记会出现在光

标的位置。这说明光标正处于元件电气连接点的位置。 

4.单击或者按下 ENTER 键来确定第一个连线点。移动光标，会出现一个从连接点

到光标位置，随着光标延伸的线。 

5.在 R1 的下方 Q1 的电气连接点的位置放置第二个连接点，这样第一根连线就快

画好了。 

6. 把光标移动到 Q1 的最下面，当位置正确时，一个红色的连接标记会出现在光

标的位置。单击或者按下 ENTER 键来连接 Q1 的基点。 

7.光标又重新回到了十字准线cross hair状态，这说明可以继续画第二跟线了。

可以通过点击右键或者按下 ESC 来完全退出绘线状态，不过现在还不要退出。 

8.现在连接C1到Q1和R1。把光标放在C1左边的连接点上，单击或者按下ENTER，

开始绘制一个新的连线。水平移动光标到 R1 与 Q1 所处直线的位置，电气连接点

将会出现，单击或按下 ENTER 来连接该点。这样两根直接便自动的连接在一起了。 

9.按照图 6-3 绘制电路剩下的部分，如图 6-8。 

 

图 6-8 完成布线的原理图 

10.当完成所有连线的绘制时，单击右键或按下 ESC 来退出画线模式。光标回到

原来的状态。 

11.如果想移动元件跟连接他的连线，当移动元件的时候按下并保持按下 CTRL

键，或者选择 Move>>Drag。 

网络和网络标记 

每个元件的管脚连接的点都形成一个网络。例如一个网络包括了 Q1 的基点，R1

的一个脚和 C1 的一个脚。 

为了能够简单的区分设计中比较重要的网络，可以设置网络标记。接下来放置两

个电源网络标记： 

1.选择 Place>>Net Label。一个带点的框将贴着光标。 

2.在放置前，通过 TAB 键打开 Net Label dialog。 

3.在 Net 栏输入 12V，点 OK 关闭。 

4.在电路图中，把网络标记放置在连线的上面，当网络标记跟连线接触时，光标



会变成红色十字准线 red cross。如果是一个灰白十字准线的 cross，则说明放

置的是管脚。 

5.当完成第一个网络标记的绘制，仍处于网络标记模式，在放置第二个网络标记

前，可以按下 TAB 键，编辑第二个网络。 

6.在 Net 栏输入 GND，点击 OK 关闭。然后放置标记。 

7. 在电路图中，把网络标记放置在连线的上面，当网络标记跟连线接触时，光

标会变成red cross红色十字准线。单击右键或按下ESC退出绘制网络标记模式。 

8.选择 File>>Save ，保存电路图同时保存项目。  

恭喜用户完成第一使用 Altium Designer 绘制的电路原理图。在把原理图变成电

路板之前，必须设置项目的选项。 

设置工程选项 

工程选项包括了：error checking parametersError Reporting，a connectivity 

Connectivity matrixMatrix，Class Generator，the Comparator setup，ECO 

generationGeneration，output paths and netlist optionsOptions（输出路

径和网表），Multi-Channel naming formats，Default Print setups，Search 

Paths 以及任何用户想制定的工程元素。当编译工程的时候，Altium Designer

将会用到这些设置。 

 

图 6-9 工程选项的设置 

当编译一个工程时，将用到电气完整性规则来校正设计。当没有错误的时候，重

编译的原理图设计将被装载进目标文件。例如通过生成 ECOs 来产生 PCB 文件。



工程允许比对源文件和目标文件之间存在的差异，并同步更新两个文件。 

所有与工程相关的操作，都可在 Project 对话框的 Options（Project>>Project 

Options）里设置，如错误检查，文件对比，ECO generation。具体请参看图 6-9。 

工程输出，例如装配输出和报告可以在 File 菜单选项中设置。用户也可以在 Job 

Options 文件（File>>New>>Output Job File）中设置 Job 选项。更多关于工程

输出的设置如下所示。 

选择 Project>>Project Options，某个工程的选项对话框便会打开 

在这个对话框中可以设置任意一个与工程相关的选项。如图所示为怎样改变

Error Reporting 中各项的报告方式。 

检查原理图的电气属性 

在 Altium Designer 中原理图图表不仅仅是简单的图，它包括了电路的电气连接

信息。用户可以运用这些连接信息来校正自己的设计。当编译工程时，Altium 

Designer 将根据所有对话框中用户所设置的规则来检查错误。 

设置 Error Reporting 

Error Reporting 用于设置设计草图检查。Report Mode 设置当前选项提示的错

误级别。级别分为 No Report， Warning， Error， Fatal Error，点击下拉框

选择即可，如上图所示。 

设置 Connection Matrix 

Connection Matrix 界面显示了运行错误报告时需要设置的电气连接，如各个引

脚之间的连接，可以设置为四种允许类型。如图所示的矩阵给出了一个原理图中

不同类型连接点的图形的描绘，并显示了他们之间的连接是否设置为允许。 

如图 6-10 中所示的矩阵图表，先找出 Output Pin，在 Output Pin 那行中找到

Open Collector Pin 列，行列相交的小方块呈橘黄色，这说明在编译工程时，

Output Pin 与 Open Collector Pin 相连接会是产生错误的条件。 



 

图 6-10 设置 Connection Matrix 

用户可以根据自己的要求设置任意一个类型的错误等级，从 no report 到 fatal 

error 均可。右键可以通过菜单选项控制整个矩阵。 

改变 Connection Matrix 的设置 

点击 Connection Matrix 界面 

点击两种连接类型的交点位置，例如 Output Sheet Entry 和 Open Collector 

Pin 的交点位置。 

点击直到改变错误等级。 

设置 Comparator 

Comparator 界面用于设置工程编译时，文件之间的差异是被报告还是被忽略。

选择的时候请注意选择，不要选择了临近的选项，例如不要将 Extra Component 

Classes 选择成了 Extra Component。 



 

图 6-11 设置 Comparator  

点击 comparator 界面，在 Asscoiated with Component 部分找到 Changed Room 

Definitions，Extra Room Definitions 和 Extra Component Classes 选项。 

将上述选项的方式通过下拉菜单设置为 Ignore Differences，如图 6-11 所示。 

现在用户便可以开始编译工程并检查所有错误了。 

编译工程 

编译工程可以检查设计文件中的设计草图和电气规则的错误，并提供给用户一个

排除错误的环境。我们已经在 Project 对话框中设置了 Error Checking 和

Connection Matrix 选项。 

要编译多频振荡器工程，只需选择 Project>>Compile PCB Project。 

当工程被编译后，任何错误都将显示在 Messages 上，点击 Messages 来查看错误

（View>>Workspace Panels>>System>>Messages）。工程已经编译完后的文件，

在 Navigator 面板中将和可浏览的平衡层 次（flattened hierarchy），元器件，

网络表和连接模型一起，被将列出所有对象的连接关系在 Navigator 中。 

如果电路设计的完全正确，Messages 中不会显示任何错误。如果报告中显示有

错误，则需要检查电路并纠正确保所有的连线都是正确的。 

现在故意在电路中引入一个错误，再编译一次工程。 

在设计窗口的顶部点击激活 Multivibrator.SchDoc。 

选中 R1 和 Q1 的 B 极之间的连线，点击 DELETE 键删除此线。 

再一次编译工程（Project>>Compile PCB Project）来检查错误。 



Messages 中显示警告信息，提示用户电路中存在未连接的引脚。如果 Messages

窗口没有弹出，选择 View>>Workspace Panels>>System>>Messages。 

双击 Messages 中的错误或者警告，编译错误窗口会显示错误的详细信息。从这

个窗口，用户可以点击错误直接跳转到原理图相应的位置去检查或者改正错误。 

下面将修正上文所述的原理图中的错误 

点击激活 Multivibrator.SchDoc。 

在菜单中选择 Edit>>Undo，或者使用快捷键 Ctrl+Z，原先被删除的线将恢复原

状。 

检查 Undo 操作是否成功，重新编译工程（Project>>Compile PCB Project）来

检查错误。这时 Messages 中便会显示没有错误。 

在菜单中选择 View>>Fit All Objects，或者使用快捷键 V，F，来恢复原理图预

览并保存没有错误的原理图。 

保存工程文件。 

现在已经完成了设计并且检查过了原理图，可以开始创建 PCB 了。 

创建一个新的 PCB 文件 

在将原理图设计转变为 PCB 设计之前，需要创建一个新的 PCB 和至少一个板外形

轮廓（board outline）。在 Altium Designer 中创建一个新的 PCB 的最简单的

方法就是运用 PCB 板向导，它可让您根据行业标准选择自己创建的自定义板的大

小。在任何阶段，都可以使用 后退按钮检查或修改该向导的之前页面。 

 
图 6-12 PCB 板向导 

用 PCB 向导创建一个新的 PCB 用的 PCB 向导，步骤如下：  

1. 创建一个新的 PCB，点击 PCB Board Wizard，在 Files 底部的 New from 

Template 选项内点击 PCB Board Wizard 部分。如果在屏幕上没有显示此选项，

按一下向上箭头图标关闭一些上层上面的选项。  

2. 打开 PCB Board Wizard 向导界面，单击下一步继续。  



3. 设置测量单位 Imperial，例如 1000mil = 1 英寸。  

4. 向导的第三页可选择需要的板纲要形。本页将确定我们自己的电路板尺寸。

从板纲要形列表中选择 Custom，并点击下一步。  

5. 在下一页，输入自定义板的选项。对于例子给出的电路，2 × 2 英寸的板便

足够了。在 Width 和 Height 中选择 Rectangular 和 type 2000。取消选择 Title 

Block＆Scale，Legend String 和 Dimension Lines。单击 Next 继续。 

6. 此页用于选择板的层数。例子中的电路需要两层信号层而并不需要电源层。

单击 Next 继续。  

7. 选择 thruhole vias only 设置设计中的孔类型，并点击 Next。  

8. 下一页用于设置元件/布线选项。选择 Through-hole components 选项并设置

One Track 与临近焊盘之间可以通过的线的数量。单击 Next。 

9. 下一页用于设置一些设计规则，如线的宽度和孔的大小。离开选项则设置为

默认值。单击下 Next。  

10. 单击 Finish。PCB Board Wizard 已经设置完所有创建新板所需的信息。PCB

编辑器现在将显示一个新的 PCB 文件，名为 PCB1.pcbdoc。 

11. PCB 文件显示出一个预设大小的白色图纸和一个空板（黑色为底，带栅格），

如图 6-13 所示。如果需要关闭，选择 Design>>Board Options，并在板设置对

话框中取消选择 Display Sheet。用户可以用 Altium Designer 的其它 PCB 模板

来添加边界，栅格参考和标题。 

如需了解更多有关 board shapes，sheets 和 templates，请翻阅参阅 Preparing 

the Board for Design Transfer 手册。 

 
图 6-13 PCB 文件 

12. 现在图纸已关闭，如需显示板的形状，选择 View>>Fit Board [快捷键: V，

F]。 

13. PCB 文件自动添加（连接）工程并被列在 Projects 中源文件里工程名的下



方。通过选择 File>>Save As 重新命名新的 PCB 文件（带.PcbDoc 扩展名）。浏

览到用户想存储PCB的位置，在File Name里键入文件名multivibrator.pcbdoc，

并点击 Save。 

在工程中添加一个新的 PCB 

如果要将PCB文件作为自由文件添加到一个已经打开的工程中，则需在Projects

中右键单击 PCB 工程文件，并选择 Add Existing to Project。选择新的 PCB 文

件名并点击打开。 现在 PCB 文件已经被列在 Project 下的 Source Documents

中，并与其它工程文件相连接。用户也可直接将自由文件拖拉到工程文件下。保

存工程文件。 

导入设计 

在将原理图的信息导入到新的 PCB 之前，请确保所有与原理图和 PCB 相关的库是

可用的。因为只有默认安装的集成库被用到，所以封装已经被包括在内。 如果

工程已经编译并且原理图没有任何错误，则可以使用 Update PCB 命令来产生

ECOs（Engineering Change Orders 工程变更命令），它将把原理图的信息导入

到目标 PCB 文件。  

 
图 6-14 信息导入 

更新 PCB  

将原理图的信息转移到目标 PCB 文件：  

1. 打开原理图文件，multivibrator.schdoc。 

2. 选择 Design>>Update PCB Document（multivibrator.pcbdoc）。该工程被

编译并且工程变更命令对话框显示出来，如图 6-14 所示。  



3. 点击 Validate Changes。如果所有的更改被验证，状态列表(Status list)

中将会出现绿色标记。如果更改未进行验证，则关闭对话框，并检查 Messages

框更正所有错误。  

4. 点击 Execute Changes，将更改发送给 PCB。当完成后，Done 那一列将被标

记。  

5. 单击 Close，目标 PCB 文件打开，并且已经放置好元器件，结果如图 6-15 所

示。如果用户无法看到自己电路上的元器件，请使用快捷键 V，D

（View>>Document）。 

 
图 6-15 元器件封装放置完成 

印刷电路板（PCB）的设计 

现在，我们开始摆放在 PCB 上的元器件及进行布线。 

对 PCB 工作环境的设置 

在我们开始摆放元器件在板上之前，我们需要对 PCB 工作环境进行相关设置，例

如：栅格、层以及设计规则。PCB 编辑工作环境允许 PCB 设计在二维及三维模式

下表现出来。 

二维模式是一个多层的、理想的普通 PCB 电路设计的环境，如放置元器件，电路

和连接。三维模式对检验用户的设计的表面及内部电路都非常有用（三维模式不

支持提供二维模式下的全部功能） 。您可以通过：File>>Switch To 3D，或者

File>>Switch To 2D[快捷键为 2（二维）、3（三维）]来切换二维与三维模式。 

栅格 

在开始摆放元器件之前我们必须确保我们的所用栅格的设置是正确的。所有放置

在 PCB 工作环境下的对齐的线组成的栅格称为 snap grid 捕获栅格。此栅格需要

被设置以配合用户打算使用的电路技术。 

我们的教程中的电路使用具有最小的针脚间距 100mil 的国际标准元器件。我们

会设定 snap grid 为最小间距的公因数，例如 50mil 或 25mil ，以便使所有的

元器件针脚可以放置在一个栅格点上。此外，我们的板的线宽和安全间距分别是

12mil 和 13mil（为 PCB Board Wizard 所用的默认值） ，最小平行线中心距离

为 25mil。因此，最合适 snap grid 的设置是 25mil。 



 
图 6-16 栅格的设置 

设置 snap grid 需完成以下步骤： 

选择 Design>>Board Options[快捷键分别为：D、O] 打开板 Options 对话框。 

利用下拉列表或输入数字设置 Snap Grid 和 Component Grid 的值为 25mil。请

注意，此对话框也可以用来界定 Electrical Grid。这一栅格作用于用户放置电

气对象的时候;它凌驾于与snap Snap gridGrid和 snap电气的对象在Component 

Gird 一起使用。单击 OK 以关闭该对话框。 

让我们设置其他可以令放置元器件更容易的 Options。 

选择 Tools>>Preferences[快捷键：T、P]打开偏好设定对话框。按下 PCB 

Editor-General 在对话框中的选择树（左侧面板）显示 PCB Editor-General 的

页面。在编辑 Options 部分，确保 Snap to Center 的选项是启用的。这可确保

当您"拖拉"一个元器件并放置它的时候，光标是设定为元器件的参考点。 

按下 PCB Editor-Display。在 DirectX Options 部分的页面，选中 Use DirectX 

if possible 的选项。如图 6-16 所示。这将使我们能够利用最新的 3D 视图模式。

按下 OK 关闭优先偏好设定对话框。 

注： Altium Designer 的 3D 视图模式，需要 DirectX 9.0c 的和 Shader Model 3

或更高版本上运行，以及一个合适的图形卡。如果用户不能运行 DirectX 的用户

将被限制使用三维视图。 



定义层堆栈和其他非电气层的视图设置 

View Configurations 包括许多关于 PCB 工作区二维及三维环境的显示选项和适

用于 PCB 和 PCB 库编辑的设置。保存任何 PCB 文件时，最后使用的 视图设置也

会被随之保存。这使得它可被 Altium Designer 的另一个使用其关联视图设置的

实例所启调用。视图设置（View Configurations）也可以被保存在本地和被使

用并用于任何时候的任何 PCB 文件。用户打开任何没有相关的视图设置（View 

Configurations）的 PCB 文件，它都将使用系统默认的配置。 

注：View Configurations 对话框提供层的二维色彩设置和其他系统基础的颜色

设置-这些都是系统设置，它们将用于所有的 PCB 文件，并且不是 View 

Configurations 的一部分。二维工作环境的颜色配置文件也可以创建并保存，

并可被以用在任何时间随时调用，视图配置亦然。 

选择 Design>>Board Layers & Colors[快捷键：

L]从主菜单中打开 View Configurations 对话框。此对话框可让您定义、编辑、

加载和保存的视图设置。它的设定是用以控制哪些层显示、如何显示共同对象，

例如覆铜、 p，焊盘、线、字符串等、显示网络名和参考标记、透明层模式和单

层模式显示、三维表面透明度和颜色及三维 PCB 整体显示。 

用户可以使用View Configurations对话框查看或直接从PCB的标准工具栏的下

拉列表中选择它们。图 6-17 示出了视图设置对话框。 

 
图 6-17 视图设置 

如果用户看 PCB 工作区的底部，用户会看到一系列层的标签，用户执行的大部分

编辑动作都在某一层。 



PCB 编译器中有三种层： 

Electrical layers-其包括 32 个信号层和 16 个内电层。电气层可以在 Layer 

Stack Manager 对话框中添加或移除，选择 Design>>Layer Stack Manager 来显

示它。 

Mechanical layers-它有 16 个决定板的形状、尺寸的普通机械层（general 

purpose mechanical layers），包括制作的细节或任何其他机械设计的细节要

求。这些层可以有选择性地包括在打印输出和 Gerber 的输出中。您可以在 View 

Configurations 对话框中添加、删除和命名机械层。 

Special layers-其包括顶部和底部的丝网印刷层、阻焊接层和粘贴层的蒙版层

锡膏层、钻孔层、Keep-Out 层（用来界定电气界限的），多综合层（用于多层

焊盘和过孔） ，连接层、DRC 错误层，栅格层和过孔洞层。 

让我们为此教程创造一个简单的二维视图设置。 

1.  

1. 选择 Design>>Board Layers & Colors[快捷键：L]打开 View Configurations 对话

框。打开对话框，在 Select PCB View Configuration 下选择动作配置。如果用

户在三维模式下，点击二维的配置。 

2. 在 Board Layers & Colors 页面中，选择 Only show layers in layer stack 和 Only 

show enabled mechanical layers 选项。这些设置显示只有在堆栈中的层。 

3. 单击在页面上的 Used Layers On 按钮。令其只显示正被使用的层。即是有设

计在上面的层。 

4. 单击颜色紧邻 Top Layer 显示 2D System Colors 对话框并从 Basic 颜色列表中

选择#7（黄色）。单击 OK 以返回 View Configurations 对话框。 

5. 单击颜色紧邻 Bottom Layer 显示 2D System Colors 对话框并从 Basic 颜色列表

中选择#228（亮绿色）。单击 OK 以返回 View Configurations 对话框。 

6. 单击颜色紧邻 Top Overlay 显示 2D System Colors 对话框并从 Basic 颜色列表

中选择#233（白色）。单击 OK 以返回 View Configurations 对话框。 

7. 确定这四个Mask层和Drill Drawing层不会被确定的每个层的 Show选项屏蔽

显示。 

8. 在 Actions 选择中，单击 Save As view configuration 并保存文件如

tutorial.config_2dsimple。 

9. 单击 OK 当用户返回 View Configurations 对话框以应用所作改变及关闭对话

框。 

注：记得 2D 层颜色设定是基于系统的、将应用于所有 PCB 文件，并不是任何视

图文件的一部分。用户可以创建、编辑和保存2D颜色设置文件从2D System Color

对话框中。 

Layer Stack Manager（层堆栈管理） 

例子的 PCB 是一个简单的设计，可以用单层板或者双层板进行布线。如果设计较

为复杂，用户可以通过 Layer Stack Manager 对话框来添加更多的层。  

1、选择 Design>>Layer Stack Manager [快捷键: D， K]，显示层堆栈管理对

话框，如图 6-18 所示。  



2、新的层将会添加到当前选定层的下方。层电气属性，如铜的厚度和介电性能，

将被用于信号完整性分析。单击 OK 以关闭该对话框。  

图 6-18 层堆栈管理 

设置新的设计规则 

PCB 编辑器是一个以规则为主导的环境，这意味着，在用户改变设计的过程中，

如画线，移动元器件，或者自动布线，Altium Designer 都会监测每个动作，并

检查设计是否仍然完全符合设计规则。如果不符合，则会立即警告，强调出现错

误。在设计之前先设置设计规则可以让用户 集中精力设计，因为一旦出现错误

软件就会提示。 

设计规则总共有 10 类，进一步化分为设计规则的类型。设计规则，包括电气，

布线，工艺，放置和信号完整性的要求。  

 

图 6-19 设计规则 

现在来设置新的设计规则，指明电源线必须的宽度。具体步骤如下：  

1 、激活 PCB 文件，选择菜单中的 Design>>Rules。  

2 、如图 6-19，PCB 规则和约束限制编辑器对话框就会出现。每个规则类显示在

对话框左边 Design Rules 文件夹的下面。双击 Routing 扩展，看到相关的布线

规则。然后双击 Width，显示宽度规则。  



3 、点击选择每条规则。当用户点击每条规则时，右边的对话框的上方将显示该

规则的范围（用户想要的这条规则的目标），下方将显示规则的限制。这些规则

不仅是预设值，还包括了新的 PCB 文件创建时在 PCB Board Wizard(PCB 板向导)

中设置的信息。  

4 。点击 Width 规则，显示其范围和约束限制。本规则适用于整个板。 

 
图 6-20 设置 Width 规则 

Altium Designer 的设计规则系统的一个强大的功能是同种类型可以定义多种规

则，每个目标有不同的对象。每个规则目标的确切设置是由被规则的范围决定义

的。规则系统使用一个预定义层次，来确定规则适应对象。  

例如，一块板可以先设置一个宽度约束规则，然后地线设定第二个宽度约束规则，

某些连接地的线设定第三宽度约束规则（独立于前两个规则）。规则按照优先顺

序显示。  

目前已经有一个宽度约束规则适用于整个板（宽度 = 12mil）。现在将为 12V

和 GND 网络添加一个新的宽度约束规则（宽度 = 25mil）。添加新的宽度约束规

则，步骤如下：  

1 、找到 Design Rules 文件夹下的 Width，点击右键选择 New Rule 来添加一个

新的宽度约束规则，只设置 12V 网络。  

命名为width_1的一项新的规则出现了。在Design Rules文件夹中点击新规则，

来修改线宽的范围和约束。  

2 、在 Name 里键入 12V 或 GND。当单击返回时，名称会在 Design Rules 里自动

更新。 

3 、下一步使用 Query Builder 来设置规则的范围，也可以随时在范围内直接键

入。如果用户觉得 Query 比较复杂，可以选择 Advanced 选项，单击 Query Helper

按钮来使用 Query Helper 对话框。  

4 、点击 Query Builder 按钮，在 Board 对话框中打开 Building Query。  



 

图 6-21 设置规则的范围 

5 、点击 Add first condition，从下拉菜单中选择 Belongs to Net。在 Condition 

Value 中，从列表中点击并选择网络 12V。Query Preview 现在便读到了 InNet

（'12v'）。  

6 、点击 Add another condition 来增加定义 GND 的宽度。选择 Belongs to Net

和 GND 作为 Condition Value。  

7 、点击 AND，在下拉菜 

单中选择 OR。检查预览显示 InNet（'12v'）OR InNet（'GND'）。  

8 、单击 OK 来从 Board 对话框中关闭 Building Query。  

9 、在 PCB Rules 的底部和 Constraints Editor 对话框中，点击约束值(10mil)

并键入新的值，将 Min Width， Preferred Width 和 Max Width 改变为 25mil。

新规则现在已经被设置，可以选择设置其它规则或者保存并关闭对话框。  

 

图 6-22 新规则设置完成 

10 、最后，点击编辑原来的规则命名宽度（范围设定为所有），并确认 Min Width， 

Preferred Width 和 Max Width 都设置为了 12mil。单击 OK 关闭该对话框。 

当手工布线或者自动布线时，所有的先将会 12mil 宽，除了 GND 和 12V 是 25mil

宽。 



在 PCB 上摆放元器件 

现在我们开始摆放元器件到正确的地方。 

1. 按下快捷键 V、D 来进行放大板以及元器件。 

2. 摆放排针 Y1，将光标移到 connector 的轮廓的中间，点击并按住鼠标左键。光标将

变更为一个十字准线交叉瞄准线并跳转到附件的参考点。同时继续按住鼠标按钮，

移动鼠标拖动的元器件。 

3. 向着板的左手边放置封装（确保整个元器件保持在板的边界内），如图 6-23。 

4. 当确定了元器件的位置后，释放鼠标按键让它落进当前区域。值得注意的是元器件

的飞线随着元件被拖动的情况。 

5. 以图 6-23 为范例，重新摆放其余元器件。当用户拖动元器件的时候可用空格键进行

必要的旋转（每次向逆时针方向转 90 º），使连接线如图 6-5 所示 。不要忘记，当

用户在摆放每一个元器件的时候要重新优化飞线。 

 
图 6-23 元器件放置在板上 

元器件文字可以通过相类似的方式重新摆放——点击并拖拉文字，及按下空格键

进行旋转。 

Altium Designer 同时包括强大的互动摆放的工具。让我们使用这些以确保四个

电阻器是有较佳的对齐和空间。 



 

图 6-24 元器件的重新摆放 

按住 SHIFT 键，分别单击四个电阻器进行选择，或者点击并拖拉选择框包围四个

电阻器。选择框会显示在每个选定且颜色设置为系统所选择颜色的元器件周围。 

要改变这种颜色的设置，选择 Design>>Board Layers & Colors[快捷键：L]。 

点击右键并选择 Align>>Align[捷径：A，A] 。在 Align Objects 对话框中，点

击 Space Equally 在 Horizontal 选项并按一下 Top 在 Vertical 选项中。四个电

阻现在对齐并有同样间隔。 

在设计窗口中单击其他地方，取消选择所有电阻。 

改变封装 

现在那些我们放置好的封装里，电容的封装相对于我们的要求太大！让我们把它

的封装改成更小的。 

1. 首先，我们将浏览一个新的封装。按一下 Libraries 面板，并从 Libraries 列表中选择

Miscellaneous Devices.IntLib。我们需要有一个较小径向类型的封装，所以在 Filter 区

域内输入 rad。按一下库名称的旁边的...按钮，并在当前 library 中选择 Footprints 选

项来显示封装。按一下该封装的名字以看见关联的封装。封装 RAD- 0.1 就合适了。 

2. 在 Component 对话框中双击该电容器和改变封装为 RAD - 0.1。用户可以键入新的封

装名称，或者按下...按钮，从 Browse Libraries 对话框中选择一个封装。单击 Ok，新

的封装会在板上显示。按照要求重新定位该标识符。现在用户的板应看起来就像图

6-25 所示。 



 

图 6-25 元器件使用新的封装放置在板上 

在所有元器件都摆放好后，就需要进行布线的工作了！ 

可以在 PCB 文件中，使用组合 CTRL 键和箭头键（纵向或横向）或 CTRL、SHIFT

和箭头键移动选定的物体。选择对象的移动基于 Board Options 对话框（Design 

» Board Options[快捷键：D，O）中的当前 Snap Grid 设置。您可以使用对话框

来设定网格预置值。使用快捷键 G来遍历不同的 snap grid 的设置值。用户也可

以使用 View » Grids 子菜单或 Snap Grid 右键点击菜单来完成。 

被选择的对象可以在按住 Ctrl 键的同时按箭头键少量地移动（根据目前的 Snap 

Grid 值）。被选择的对象也可以在按住 Ctrl 和 Shift 键的同时按箭头键来实现

大幅度的移动（Snap Grid 值的 10 的倍数）。 

手动布线 

布线是在板上通过走线和过孔以连接组件的过程。Altium Designer 通过提供先

进的交互式式布线工具以及 Situs 拓扑自动布线器来简化这项工作，只需轻触一

个按钮就能对整个板或其中的部分进行最优化走线。 

而自动布线提供了一种简单而有力的布板方式，在有的情况下，用户将需要精确

的控制排布的线，或者用户可能想享受一下手动布线的乐趣！在这些情况下您可

以手 动为部分或整个板子布线。在这一节的教程中，我们将手动对单面板进行

布线，将所有线都放在板的底部。交互式布线工具可以以一个更直观的方式，提

供最大限度 的布线效率和灵活性，包括放置导线时的光标导航、接点的单击走

线、推挤或绕开障碍、自动跟踪已存在连接等等，这些操作都是基于可用的设计

规则进行的。 

我们现在在"ratsnest "连接线的引导下在板子底层放置导线。 

在 PCB 上的线是由一系列的直线段组成的。每一次改变方向即是一条新线段的开

始。此外，默认情况下， Altium Designer 会限制走线为纵向、横向或 45 °的

方向，让您的设计更专业。这种限制可以进行设定，以满足用户的需要，但对于

本教程，我们将使用默认值。 



1. 用快捷键 L 以显示 View Configurations 对话框，其中可以使能及显示 Bottom Layer。

在 Signal Layers 区域中选择在 Bottom Layer 旁边的 Show 选项。单击 OK，底层标签

就显示在设计窗口的底部了。 

2. 在菜单中选择 Place>>Interactive Routing [快捷键：P、T]或者点击 Interactive Routing

按键。光标将变为十字准线十字，显示用户是在线放置模式中。 

 

图 6-26 手动布线检查文档工作区底部的层标签。Top Layer 标签当前应该是激活的。

通过按下*键，来在不退出走线模式的情况下切换到底层。此键在可用信号层中循环。

Bottom Layer 标签会被激活。 

3. 将光标定位在排针 Y1 较低的焊盘。点击或按下 ENTER ，以确定线的第一点起点。 

4. 将游标移向电阻 R1 底下的焊盘。注意：线段是如何跟随光标路径来在检查模式中显

示的（图 6-26）。检查的模式表明他们还没被放置。如果用户沿光标路径拉回，未连

接线路也会随之缩回。在这里，用户有两种走线的选择：  

o CTRL+单击使用 Auto-Complete 功能，并立即完成布线（此技术可以直接使用

在焊盘或连接线上）。起始和终止焊盘必须在相同的层 内布线才有效，同时

还要求板上的任何的障碍不会妨碍 Auto-Complete 的工作。对较大的板，

Auto-Complete 路径可能并不总是有效的， 这是因为走线路径是一段接一段

地绘制的，而从起始焊盘到终止焊盘的完整绘制有可能根本无法完成。 

o 使用 ENTER 或点击来接线，用户可以直接对目标 R1 的引脚接线。这种方法

为走线提供了控制，并且能最小化用户操作的数量。 

5. 未被放置的线用虚线表示，被放置的线用实线表示。 

6. 使用上述任何一种方法，来在板上的其他元器件之间布线。图 6-26 显示了一个手工

布线的板。 

7. 保存设计[快捷键：F，S 或者 Ctrl + S]。 

Altium Designer 的交互式布线工具提供了可以用来解决布线时的冲突与障碍的

功能。在交互式布线模式下，通过使用 SHIFT+R 来遍历这些模式。可用的模式有：  

Push——这种模式将试图移动目标（线和孔），它们可以被重定位来适应新的布

线。 

Wwalkaround——这种模式将试图找到一个布线路径绕过已经存在的障碍而不去



移动它们。 

Hug＆Push——这种模式结合了 Walkaround 和 Push 的功能。它会绕过障碍，然

而也会考虑采用 Push 模式来对待固定的障碍。 

Ignore——这种模式可让用户在任何地方布线。  

在交互式布线过程中，如果尝试布线到一个区域，使用 Push or Hug & Push 模

式仍然无法完成布线，无法完成布线的提示便会立即出现（图 6-27）。  

 
图 6-27 Push or Hug & Push 模式仍然无法完成布线，会立即出现提示 

关于布线的几点提示 

布线的时候请记住以下几点：  

•点击或按下 ENTER，来放置线到当前光标的位置。检查模式代表未被布置的线，

已布置的线将以当前层的颜色显示为实体。 

•在任何时候使用 CTRL+单击来执行自动完成连线。起始和终止引脚必须在同一

层上，并且没有不能解决的冲突与障碍。  

•利用 Shift + R 来遍历 Push，Walkaround，Hug and Push 以及 Ignore 模式。  



 
图 6-28 双层手动布线•使用 Shift +SPACEBAR 来选择各种线的角度模式。角度

模式包括：任意角度，45 °，弧度 45 °，90 °和弧度 90 °。按空格键切换

角度。  

•在任何时间按 END 键来刷新屏幕。  

•在任何时间使用 V，F重新调整屏幕以适应所有的对象。  

•在任何时候按 PAGE UP 和 PAGE DOWN 键，以光标位置为核心，来缩放视图。使

用鼠标滚轮向左边和右边平移。按住 CTRL 键，用鼠标滚轮来进行放大和缩小。 

•按 BACKSPACE 键，来取消放置上一条线。  

•当用户完成布线并希望开始一个新的布线时，右键单击或按下 ESC 键。  

•防止不小心连接了不应该连接在一起的引脚。 

Altium Designer 不断的监察板的连通性，并防止用户在连接方面的失误。  

•要删除线，单击选择它。它的编辑操作就会出现（其余的线将突出）。按下 DELETE

键来清除所选的线段。  

•重布线是非常简便的——当用户布置完一条线并右击完成时，多余的线段会被

自动清除。 

•完成 PCB 上的所有连线后，如图 6-28 所示，右键单击或者按下 ESC 键以退出防

止放置模式。 

板的自动布线 

请完成以下步骤，用户会发现使用 Altium Designer 软件是如此的方便。  

1. 首先，选择取消布线，Tools>>Un-Route>>All，[快捷键：U，A] 。  

2. 选择 Auto Route>>All。Situs Routing Strategies 对话框弹出。按一下 Route 

All。Messages 显示自动布线的过程。  

Situs autorouter 提供的结果可以与一名经验丰富的设计师相比，如图 6-29 所

示，因为它直接在 PCB 的编辑窗口下布线，而不用考虑输入和输出布线文件。  

3. 选择 File>>Save [快捷键：F，S]来储存用户设计的板。  

注：线的放置由 autorouter 通过两种颜色来呈现：红色，表明该线在顶端的信

号层；蓝色，表明该线在底部的信号层。要用于自动布线的层在 PCB Board Wizard

中的 Routing Layers 设计规则中指定。此外，注意电源线和地线要设置的宽一

些。  

如果您设计中的布线与图 6-28 所示的不完全一样，也是正确的，因为元器件摆

放位置不完全相同，布线也会不完全相同。  



 

图 6-29 自动布线 

因为最初在 PCB Board Wizard 中确定我们的板是双面印刷电路板，用户可以使

用顶层和底层进行手工布线。为此，从菜单中选择 Tools>>Un- Route>>All，[快

捷键：U，A]来取消布线 。和以前一样开始布线，在放置线的时候使用*键来切

换层。 Altium Designer 软件在切换层的时候会自动的插入必要的过孔。 

注意 : 由自动布线器完成的布线将显示两种颜色：红色表示顶部信号层布线和

蓝色表示底层信号层布线。可用于自动布线的信号层定义是符合 PCB Board 

Wizard 中的布线层设计规则约束。还要注意两个电源网络布线更宽的间隔符合

两种线宽规则约束。不必担心，如果在你的布线设计不完全如上图所示的一样。

器件摆放的位置将不会完全一样，也可能是不同的布线样式。 

板设计数据校验 

Altium Designer is a rules-driven board design environment, in which you 

can define many types of design rules to ensure the integrity of your board. 

Typically, you set up the design rules at the start of the design process 

and then verify that the design complies with the rules as you work through 

the design, and at the end of the design process. 

Earlier in the tutorial we examined the routing design rules and added 

a new width constraint rule. We also noted that there were already a number 

of rules that had been created by the PCB Board Wizard, and that there 

were some existing design rule violations against these default rules. 



Altium Designer 支持多级设计规则约束功能。用户可以对同一个对象类设置多个规则，每条

规则还可以限定约束对象的范围。规则优先级定义服从规则的先后次序。  

为了校正电路板使之符合设计规则的要求，用户可以利用设计规则检查功能

(DRC): 

1. 选择 Design»Board Layers & Colors (快捷按键: L) 并确认复选项 Show 及 System 

Colors 区的 DRC 错误标记选项已被选取，这样 DRC 错误标记将被显示。 

2. 选择 Tools»Design Rule Check (快捷按键: T, D)，打开 Design Rule Checker 对话窗口，

使能 online 和 batch DRC 选项。 

 

规则检测，Online 和 Batch 均可以手工配置. 

3. 鼠标点击窗口左边的 Report Options 图标，保留缺省状态下 Report Options 区域

的所有选项，并执行 Run Design Rule Check 命令按钮，随之将出现设计规则检测报

告。并将同时弹出一个消息窗口。 

4. 点击违例条款 Silkscreen over Component Pads ，用户将跳转到相应违例报告区域。 

5. 点击违例条款 Silkscreen over Component Pads 的任一条记录，用户将跳转到 PCB，

并放大显示出现违例的设计区域。注意，放大的倍数取决于在 System - Navigation 

环境配置内的设置。 



 
显示每项违例的细节，本例的丝印与焊盘的间隔少于 10mil. 

6. 显示每项违例的细节, 如上图所示。注意用户可以通过 View Configurations 窗口内

的 DRC Detail Markers 配置违例的图形显示颜色。 

7. 需要找出所有实际违反丝印与焊盘间安全间距规则约束的对象，可以选择菜单 

Reports»Measure Primitives 命令。注意，用户可以通过快捷功能按键 CTRL+G 修改

电气栅格的值。如 5mil。 

8. To resolve this error we can either modify the footprint, increasing the separation, or 

we can edit the design rule, decreasing the required separation. For this tutorial we 

will edit the design rule, to do this select Design»Rules from the menus to open the 

PCB Rules and Constraints Editor dialog. 

9. In the Manufacturing category, open the Silkscreen Over Component Pads rule type, 

and click on the existing rule. 

10. Edit the Silkscreen Over Exposed Component Pads Clearance value, changing it from 

10mil to 9mil. 



 

These pads are closer than the 13mil specified in the Clearance Constraint design rule. 

 运用习惯上与检查晶体管上焊盘间的安全间距相同的技术，检查阻焊数据与焊盘之

间的间隙。 

Switch back to the PCB document and you will see that the transistor pads 

are highlighted in green, indicating a design rule violation. 

1. Look through the errors list in the Messages panel. It lists any violations that occur in 

the PCB design. Notice that there are four violations listed under the Clearance 

Constraint rule. The details show that the pads of transistors Q1 and Q2 violate the 

13mil clearance rule. 

2. Double-click on an error in the Messages panel to jump to its location on the PCB. 

Normally you would set up the clearance constraint rules before laying out your board, 

taking account of routing technologies and the physical properties of the devices. Let's 

analyze the error then review the current clearance design rules and decide how to 

resolve this situation. 

3. Open the PCB Rules and Constraints Editor dialog (Design»Rules). Expand the Electrical, 

then the Clearance rule type. There will be one Clearance design rule, click on it to 

display its settings. 

4. Note that this rule requires All objects to be away from All other objects, at least 13mil. 

Since the clearance between the transistor pads is less than this, they generate a 

violation when we run a DRC. 

5. We know that the minimum distance between the transistor pads is just over 10mil, so 

let's set up a design rule that allows the clearance constraint of 10mil for the 

transistors only. 

6. Select the Clearance type rule in the Design Rules folder on the left of the dialog, 

right-click on it, then select New Rule to add a new clearance constraint rule. 



7. Click on the new Clearance rule, Clearance_1. Change the Name to 

Clearance_Transistors, and set the Minimum Clearance to 10mil in the 

Constraints section. 

8. The final task is to set the Scope, or Full Query for the rule. There are a number of ways 

the rule could be scoped, the most appropriate in this case would be to target the rule 

to any component that uses the transistor footprint. To do that, select the Advanced 

(Query) option (in the upper section of the dialog), then click the *Query Builder 

button to open the Building Query from Board dialog. 

9. Click Condition/Type Operator dropdown to Add first condition, and select Associated 

with Footprint from the list. 

10. Set the Condition Value to BCY-W3/E4 (the footprint type being used by the transistor), 

then click OK to close the dialog. The new design rule should look like the figure shown 

below. 

 

Design rule to set the clearance for all components using a specific footprint. 

11. Click OK to close the PCB Rules and Constraint Editor dialog. The online DRC will run 

automatically, clearing the errors. 

12. To confirm that the transistor pad clearance violations have been resolved, run the 

batch design rule check again (Tools»Design Rule Check). When the report opens scroll 

down and confirm that there are no violations. 



 

一份清晰的 DRC 报告，显示了所有被判定了的违反规则的设计.  

现在，用户就完成了 PCB 版图的设计，然后可以开始产生输出数据文档。不过，

在产生输出制造数据之前，用户还可以利用 Altium Designer 的三维视图功能

查看自己设计的 PCB 板。  



在 3D 模式下查看电路板设计 

现在，您的电路板设计已经基本完成，是时候研

究一下它的 3D 模式了。3D 模式，可以让您从任何角度观察您设计的板。要在

PCB 编辑器中切换到 3D，只需选 择 View>>Switch To 3D [快捷键: 3]或者从列

表中的 PCB 标准工具栏中选择一个 3D 视图配置。 

Altium Designer 软件的 3D 环境的要求支持是 DirectX 及相关技术，并使用一

个兼容块独立的显卡。对于如何测试您的系统，以及让 Altium Designer 可以

使用 DirectX，打开 Preferences 对话框中的 PCB Editor - Display 

(Tools>>Preferences)。  

 

图 6-30 3D 旋转展示图 

您可以滑动变换大小来看，旋转，甚至在板中间看，只要您使用如下操作：  

缩放——按 Ctrl+鼠标右拖，或者 Ctrl+鼠标滚轮，或者 PAGE UP / PAGE DOWN

键。  

平移——鼠标滚轮向上/向下，SHIFT+鼠标滚轮向左/右或向右拖动鼠标来向任

何方向移动。 

旋转——按住 SHIFT 键进入 3D 旋转模式。光标处以一个定向圆盘的方式来表示

（图 6-11）。该模型的旋转运动是基于圆心的，使用以下方式控制：  

用鼠标右拖曳圆盘 Center Dot，任意方向旋转视图。  

用鼠标右拖曳圆盘 Horizontal Arrow，关于 Y 轴旋转视图。  

用鼠标右拖曳圆盘 Vertical Arrow，关于 X轴旋转视图。  

用鼠标右拖曳圆盘 Circle Segment，在 Y-plane 中旋转视图。 

您可以使用 View Configurations 对话框[快捷键: L]来设定 3D 工作区的显示

选项。可以选择各种表面和工作区的颜色以及垂直尺度，这样可以得心应手的

来检查 PCB 的内部。一些表面有一种不透明的设置—— 越大的透明度的值越大，



越少表示的光通过表面的光强度越小，使物体背面后面不明显。您也可以选择

显示 3D 物体本身或者以 2D 层的颜色来着色该 3D 对象。 

您可以将 3D STEP 格式模型导入到元器件的封装和 PCB 设计中并创建自己的 3D

物体。您也可以以 STEP 和 DWG / DXF 格式来输出 PCB 文件，以便运用到用于其

他程序中。3D Vviewer 可以导入 VRML 1.0/IGES/STEP 格式的 3D 物件，也可以

导出 IGES 和 STEP 格式的 3D 物件。 

注：任何时候在 3D 模式下，您可以以各种分辨率创建实时"快照（snapshots）

"，使用 CTRL + C 复制，这样就可以将图像（Bitmap 格式）存储在 Windows 剪

贴板中，用于其他应用程序。 

为元器件封装创建和导入 3D 实体  

到目前为止，我们已经到了最终 PCB 数据的核实查和输出阶段。Altium Designer

软件的 3D 环境提供了一个逼真的优良的供视图查看及检查 PCB 组装的环境条件，

是一个逼真的环境。  

元器件封装本身存储有 3D 模型，用于在 3D 环境下渲染该元件。此外，精确的

元器件间隙检查、甚至是装配整个 PCB 和外部的自由浮动的 3D 机械物体外壳都

是 可能的。这将用到机械 CAD 软件包，创建一个设计一体化的新的水平，这些

Altium Designer 软件正好可以提供。  

如需要为元器件创建 3D 实体的详细资讯，请查找 Creating Library Components

教程中的 3D 元器件详细部分。  

如需用MCAD软件进行3D实体一体化设计的更多信息，请查找 Integrating MCAD 

Objects and PCB Designs 教程。  

在 Integrating MCAD Objects and PCB Designs 教程中，我们设计的板已经通

过器件的 3D 模型完成了（图 6-31）。教程将用机械外壳来装起整块板（图 6-32）。

板和元器件可以在 Altium Designer 软件安装中的 

Examples/Tutorials/multivibrator_step 文件夹中找到。 

 

图 6-31 3D 效果图 



 
图 6-32 .装配效果图 

检验 PCB 板设计 

Altium Designer 提供了一个规则驱动设计环境，在这里能够设计 PCB，并且允

许我们定义很多类型的设计规则来保证我们的 PCB 设计的完整性。典型地，我

们在设计过程开始时建立设计规则，再在设计过程结束后用这些规则来校验修

正设计标准。 

在较早的教程指南中，我们检查了布线设计的规则和增添了一个新的宽度约束

规则。我们还注意到，已经有一些由 PCB Board EizardWizard 创建的规则。 

为了核实已经布好的电路板遵守设计规则，我们来执行设计规则检查（DRC）： 

1. 选择 Design>>Board Layers & Colors（快捷键：L），保证在 System Colors 部分中的

DRC Error Markers选项中的 Show按钮已经使能（打钩），以保证显示DRC错误标记。 

2. 选择 Tools - Design Rule Check（快捷键：T，D）。保证在 Design Rule Checker 对话框

的实时和批处理设计规则检测都被配置好。在其中一个各类上单击，比如：Electrical，

可以看到属于那个种类的所有规则。 

3. 保持所有选项为默认值，点击 Run Design Rule Check 按钮。DRC 就开始运行，报告

文件 Multivibrator.DRC 就打开了。错误结果也会显示在信息面板。点击进入 PCB 文

件，我们将会看 到，该晶体管的焊盘是以绿色突出显示的，显示违反设计规则。 

4. 通过在信息面板中看错误报告清单，它列出发生在 PCB 设计的任何违反规则行为。

注意有四种列出在清除约束规则中的违反规则。细节表明，晶体管 Q1 和 Q2 违反

13mil 的最小安全距离规则。 



 

图 6-33 保持所有选项为默认值 

1. 双击 Messages 面板中的错误，可以跳到对应的 PCB 中的位置。 

通常，我们会在布线之前，设置我们的安全距离规则，同时考虑到布线技术和

设备的物理性能。让我们分析错误，然后再次检查现行的安全距离设计规则和

决定如何解决这种情况。 

 

图 6-34 错误信息 

为了找出两个晶体管焊盘间的真实最小安全距离，有以下步骤： 

1. 选中 PCB 文件，光标定位于一个晶体管，按下 PAGE UP 键来放大视图影像。 

2. 选择 Reports - Measure Primitives(快捷键：R，P)。光标将变成十字形字准线。 

3. 使光标定位于晶体管左边的焊盘中间，并点击或按下 ENTER 。因为光标是超过两焊

盘和连接它的布线，一个菜单会弹出让用户选择所需的对象。从弹出式菜单中选择

晶体管的焊盘。 



4. 再一次，使光标定位于晶体管中间，并点击或按下 ENTER 。从弹出式菜单中选择晶

体管的焊盘。一个显示最小距离的信息框打开了，显示两个焊盘边缘的最小距离是

10.63mil 。 

5. 关闭信息对话框，右键单击或按下 ESC 退出测量模式，然后使用 V 、F 的快捷键，

重新缩放文件。 

让我们看看当前的安全距离设计规则： 

1. 从菜单中选择 Design - Rules （快捷键：D，R）来打开 PCB Rules and Constraints Editor

对话框。双击 Electrical 种类，在右边的对话框显示所有的电气规则。双击该安全距

离类型，然后按一下就安全距离规则点 击"Clearance"规则一项来以打开它。该对话

框底部的区域将包含一个单一的规则，标明整个 PCB 板的最小安全距离为 13mil 。

晶体管之间的焊盘的距离小于安全距离，这就是为什么当我们运行 DRC 的时候，它

们出现了违反规则的信息。 

我们现在知道两个晶体管之间的最小焊盘距离是 10mil 多一点，让我们建立了

一个只为晶体管的设计规则，大小为 10 mil。 

1. 在设计规则文件夹中，选择安全间隙类型，点击右键并选择新规则添加一个新的安

全间隙约束规则。 

2. 点击新的安全间隙规则，Clearance_1。在 resulting 页面中的 Constraints 章节中，设

置 Minimum Clearance 为 10 mil。 

3. 点击 Advanced (Query)，再点击 Query Helper 从 Memberships Checks 去建立条件检

索，或者也可以为第一个对象（图 6-35）在接下来的条件检索中打印进去。 

HasFootprintPad('TO-92A'，'*') 

那个星号表明在封装里名为"TO-92A"的任何焊盘。 

1. 保持第二个对象范围为 ALL，并单击 OK。单击 Apply，然后点击 OK 以关闭 PCB Rules 

and Constraints Editor 对话框。 

2. 现在，我们可以从设计规则检测对话框（Tools - Design Rule Check）按一下运行设计

规则检查按钮。重新运行 DRC，不会有违反规则的行为。 

3. 保存已经完成的 PCB 和工程文件。 



 

图 6-35 使用 PCB 规则系统规定参数编辑器对话框创建规则。 

恭喜，用户已经完成了 PCB 的布局布线，准备生成输出文件。 

输出文件 

现在，您已经完成了 PCB 的设计和布线，用户想要产生输出文件，来审查，制

造和组装 PCB 板。这些文件通常用于提供给板级制造商，因为在 PCB 制造方面

有各种不同技术和方法的存在，Altium Designer 具有产生众多各种用途输出文

件的能力。 

这些用途包括： 

装配输出 

 装配图 —— 显示电路板每一面上元器件位置和原点信息-代表制板的立场和方向。 

 抓取选择和放置文件 —— 用于元件放置机械手在电路板上摆放元器件- 被智能放

置装置用来智能放置元件。 

文件输出 

 .文件产出复合综合图纸 —— -成品板组装，包括元件和线路。 

 .PCB 的三维打印， —— 采用从三维视图观察电路板立体角度的看法。 

 .示意原理图打印版画 —— 绘制设计的-原理图示意图图纸中使用的设置。 

制作输出： 

 绘制复合钻孔图综合演示图纸 —— ：在一张图纸中演示板的位置和大小绘制电路

板上钻孔位置和尺寸的复合图纸。 

 演示图纸/向导钻孔绘制/导向 —— 在多张图纸上：在不同的图纸中演示分别绘制

钻孔板的位置和大小尺寸。 

 最终的绘制图纸： —— 把所有的制作文件合成单个绘制输出。 



 Gerber 文件 ： —— 制作 Gerber 格式的制作信息. 

 NC Drill Files ——- 创建能被数控钻孔机使用的制造信息。 

 ODB++ ——- 创建 ODB++ 数据库格式的制造信息. 

 Power-Plane Prints ——- 创建内电层和电层分割图纸部多层图纸. 

 Solder/Paste Mask Prints ——- 创建阻焊层和的面具图纸锡膏层图纸。 

 Test Point Report ——- 创建在不同模式下设计的测试点的输出结果 

网表络输出 

网络列表表描述在设计上逻辑之间的元器件组件连接，对于移植到其它电子产

品设计中是非常有帮助的。 

报告输出 

 Bill of Materials ——- 为了制作板的需求而创建的一个在不同格式下部件和零件的

清单。 

 Component Cross Reference Report ——- 在设计好的原来图的基础上，创建一个组

件的列表。 

 Report Project Hierarchy ——- 在该项目上创建一个原文件的清单。 

 Report Single Pin Nets ——- 创建一个报告，列出任何只有一个连接的网络。 

 Simple BOM ——- 创建文本和该 BOM 的 CSV （逗号隔开的变量）文件。 

大部分的输出文件是用做配置的，在需要的时候设置输出。在您完成更多的设

计后，用户会发现用户经常为每个设计采用相同或相似的输出文件。 

Altium Designer 提供一个叫做 Output Job Files 的方式机制，该机制方式使

用一种接口 ——- Output Job Editor，可用于将各种输出文件捆绑在一起，

将它们发送给各种输出方式媒体（直接打印，PDF 和生成文件）。 

想得到更多使用 OutputJob Editor 的信息， 请回到 OutputJob Editor 的参

考部分 .  

想得到更多使用 打印 PDF 的信息， 请回到打印 PDF 的参考部分 .  

手动输出文件 

PCB 设计过程的最后阶段，为了更好的满足生产，我们将在指导中说明如何产生

Gerber及数控钻孔文件，和BOM 文件。我们在这里不再使用Output Job Editor，

但是使用单步的菜单命令 - 全部输出文件也可以从菜单命令中直接创建。记得

该配置输出文件是作为项目的一部分存储的。 

生成 Gerber 文件  

每一个 Gerber 文件跟板的一个层关联 ——- 器件层、顶部信号层、底部的信

号层、焊料掩蔽层等等。 



 

图 6-36 生成 Gerber 文件 

可取的做法是，在提供用于制造的输出文件之前，先咨询电路板制造商，以确

认他们的要求。 

为教程中的 PCB 创建输出文件：  

1. 选择 File>>Fabrication Outputs>>Gerber Files。该设置对话框显示。 

2. 单击 Layers tab，然后 Plot Layers 按钮，并选择 Used On。单击 OK 以接受其他默认

设置。 

3. 该 Gerber 档案产生后即被 CAM 编辑器打开显示。该 Gerber 文件存储在 Project 

Outputs 文件夹，这是自动产生的文件夹。每个文件都有反映其层次的扩展名称，

例如：multivibrator.gto 为 Gerber Top Overlay。这些都会被添加到 Projects 面板的

Generated CAM Document 文件夹中。 

类似的，选择 File>>Fabrication Outputs>>NC Drill Files 命令来打开 NC 

Drill Setup 对话框来创建没有连接的通孔数据。 

创建一个器件清单  

为教程中的 PCB 创建一个器件清单（BOM）。 

1. 选择 Reports>>Bill of Materials，显示 Bill of Materials for PCB 

Document 对话框。 



 

图 6-37 器件清单 

2. 使用此对话框，以建立起自己的 BOM 的。在用户想要输出到报告的每一栏中

都启用 Show 选项。 

3.从 All Columns 清单选择并拖动栏标题到 Grouped Columns 清单，以便在 BOM

中按该数据类型来分组元件。例如，若要以封装来分组，在 All Columns 中选

择 Footprint，并拖曳到分 Grouped Columns 清单。该报告将据此进行分类。 

4. 使能 Open Exported 选项，选择的 CSV 为文件格式，然后点击导出按钮创建

并在您的 CSV 查看器（例如 Microsoft Excel）中立即打开 BOM 的文件。还有许

多可供选择的 BOM 和其他报告的类型，这就提供了高度的灵活性。关闭对话框。 

祝贺！您已经完成了 PCB 设计过程。 

深入研究 

本教程只为用户介绍了一些 Altium Designer 的强大功能。我们学会了绘制电

路原理图，设计 PCB 和布线，但我们只学会了 Altium Designer 的一些表面的

功能。当用户深入探索 Altium Designer 的时候，用户会发现它丰富的功能，

使您的设计生活变得更轻松。大量例子均包括在内，并向用户展示了软件的功

能。您可以通过选择 File>>Open 菜单，然后展开 Altium DesigneDesigner 安

装路径中的 Examples 文件夹来打开这些例子。同时，电路板设计的例子也在此

文件夹中，有大量子文件夹的例子用于展 示了 Altium Designer 的具体特点。 

检查 Circuit Simulation 子文件夹，来探索 Altium Designer 的模拟和数字的

仿真能力。同样，模拟例子电路示例也展示了各种电路的设计，如放大器和电

源供应器，有数模混合电路模式的例子，一个数学函 数的例子，还有一个包括

线性和非线性源的例子，还有一个真空管的例子。 

随着逻辑转换和设计时钟速度的提高，高质量的数字信号变得越来越重要。

Altium Designer 包括一个先进的信号完整性分析工具，能准确的提供模型并分

析您的电路板布局。信号完整性的要求，如阻抗、过冲、下冲以及斜率被界定

为 PCB 设计规则，将在标准设计规则检查中被测试。 

如果有您需要分析得更详细分析的网络，您可以选择 Tools>>Signal Integrity

来进行信号完整性分析仪，在这里您可以进行反射和串扰分离度仿真。结果显



示在像示波器一样的波形分析仪上，在那里您可以研究性能并通过波形结果直

接进行测量。 

 


